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Q:  How do I access the StoryBooks I created in StoryBook Creator 1.0 once I have 

installed StoryBook Creator 2.0? 
 
A:  When you first open StoryBook Creator 2.0, choose “Open a project.” If your   

existing StoryBook doesn’t show in the list of recently used projects, just click on 
“More projects on my computer” and browse to the location where your StoryBook   
is saved. The default location for StoryBooks created in StoryBook Creator 1.0 is 
C:\My Documents\Creative Memories\StoryBooks. 
 

Q:  I’ve installed StoryBook Creator 2.0 but now my Memory Manager Software isn’t 
letting me move photos into a StoryBook. What happened? 

 
A:  An update was created for Memory Manager to allow it to talk to either StoryBook 

Creator 1.0 or StoryBook Creator 2.0. With your computer connected to the   
Internet, open Memory Manager and allow the software to determine if your  
software is current. If you need to install an update, a message stating, “update is 
available” will appear. Just click on the message and follow the instructions to  
update Memory Manager. 

 
Q:  Can StoryBook Creator Plus be installed and run from an external hard drive? 
 
A:  Yes, the program can be installed and run from an external drive. However, it is     

still tied to the computer where it was originally installed (i.e., you cannot take the 
software on the external drive and connect it to another computer). 

 
Q:  Can I install StoryBook Creator Plus on more than one computer? 
 
A:  StoryBook Creator Plus is licensed software. You may not install it on more than one 

computer. 
 
Q:  What’s included with StoryBook Creator 2.0? 
 
A:  The download includes the software and the Basic Black and Basic White themes in 

all three book sizes (8 x 8, 11 x 8.5, 12 x 12). 
 
Q:  What’s included with StoryBook Creator Plus? 
 
A:  The software, Everyday and Gazebo Digital Power™ Palettes, and Everyday and 

Gazebo in all three book sizes (8 x 8, 11 x 8.5, 12 x 12). 
 
Q:  What’s are Content Collection CDs? 
 
A:  A selection of digital artwork is placed on a CD so you have something tangible to 

purchase at Get Togethers. 
 
Q:  I purchased the Content Collection CD. Where do I find my activation code? 
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A:  The activation code is on the back of your CD packaging. 
 
Q:  Will all new Predesigned Pages and Digital Power™ Palettes, Kits and Additions be 

available on CD? 
 
A:  No. But the most popular themes will be available several times a year. 
 
Q:  What are the main advantages of switching to StoryBook Creator 2.0? 
 
A:  StoryBook Creator 2.0 allows you to: 

• Use multiple fonts, sizes, colors and attributes within one text box. 
• Save the program, StoryBooks and themes in any location on your computer, 

including an external hard drive. 
• Change the cover of your book at any time. 
• Use any personalized cover from any theme you have installed. 
• Save a StoryBook with a new name. 
• Create a StoryBook in any size. 
• Zoom in on your journaling to proof. 
• Preview your cover and book (in two-page spreads) before ordering. 

 
Q:  What are the main advantages of upgrading from StoryBook Creator 2.0 to 

StoryBook Creator Plus? 
 
A:  StoryBook Creator Plus allows you to take advantage of all the features in StoryBook 

Creator 2.0 plus allows you to: 
• Move, resize, recolor or rotate ANY element on the page. 
• Create StoryBooks AND individual pages of any size. 
• Print at the Creative Memories Photo Center or at home on your own printer. 
• Create StoryBooks using our exclusive themes. 
• Create StoryBooks or individual pages completely from scratch. 
• Enhance your photos by adding photo mats and photo edges, adding edge glow, 

blur or oil painting effects. 
• Make anything on your page “vellum” by adjusting the opacity. 
• Add adjustable shadows to elements on your page to create dimension. 

 
Q:  Can I create and purchase Page Prints with StoryBook Creator 2.0? 
 
A:  No. You’ll need to upgrade to StoryBook Creator Plus to create Page Prints. 
 
Q:  What is the price of the new 12 x 12 StoryBook (and the 8 x 8 and 11 x 8.5 

StoryBooks)? 
 
A:  The new 12 x 12 StoryBook retails for $79.95 for the basic 20-page book with a 

customized cover. Additional pages are $4 for two pages. The shipping on the  
12 x 12 StoryBook is the same as our other sizes – $7 for the first book and $2  
for each additional book going to the same address. 
• Our 8 x 8 StoryBooks retail for $44.95 for the basic 20-page book with a 

customized cover. Additional pages are $2.50 for two pages. 
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• Our 11 x 8.5 StoryBooks retail for $39.95 for the basic 20-page book with a    
linen cover with or without a window. An 11 x 8.5 book with either a       
customized cover or a leatherette cover with or without a window retails for 
$49.95. Additional pages are $2.50 for two pages. 

 
Q:  Can I use the free themes in both StoryBook Creator 2.0 and StoryBook Creator 

Plus? 
 
A:  Yes. You can use the free themes with either version of the software. 
 
Q:  What are Predesigned Pages? 
 
A:  Predesigned Pages are very similar to our free themes and are designed to be used 

with StoryBook Creator 2.0 or Plus. Each book size includes the standard 20-page 
book plus 10 extra page templates for $7.95. (You can find these pages by choosing 
to Change a page or Add a page within the software.) They are sold in three different 
sizes – 8 x 8, 11 x 8.5, 12 x 12. Used with StoryBook Creator 2.0 software, these 
pages remain unmovable. Simply drag and drop your photos into place, add your 
story, and you’re done. But when you’re looking for more options, use the pages in 
StoryBook Creator Plus. You can leave the page as is; or move, add, and delete 
elements, change colors; even add paper, stickers, or titles from different themes. 
They are purchased through creativememories.com or your Consultant’s Personal 
Web Site and are immediately available after purchase as a download. 

 
Q:  What are Digital Kits, Digital Power™ Palettes and Additions? 
 
A:  All are digital versions of traditional scrapbooking products, and contain individual 

papers, title stickers and embellishments. There are no predesigned pages included. 
They are designed to be used with StoryBook Creator Plus to create pages from 
scratch or to embellish our predesigned pages. They are purchased through 
creativememories.com or your Consultant’s Personal Web Site. They are 
immediately available after purchase as a download. 

 
Q:  How do I install digital artwork? 
 
A:  After you have downloaded the product to your computer, you’ll need to install them 

into the software. Simply open your software, choose “CM Content” from the top left 
corner of the home page and then choose “Import Package” from the pop-up box. 
Browse to the location where you saved the download and double-click on it to begin 
the import process. If you need a code to activate the package, it will show up as 
“Not activated.” To activate, just highlight the package and click on “Enter activation 
code.” You will find the activation code either on the back of your CD packaging (if 
you purchased as part of a content collection) or in the e-mail confirmation of your 
order (if you purchased as a download). 

 
Q:  If I have content from other digital Web sites, can I use it with StoryBook Creator 

Plus? 
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A:  Yes! You can import these into the software by choosing “My Stuff” from the home 
page of the software. To create a new collection, click on File and choose New 
Collection. Name your collection and then add to it by clicking on Content and 
choosing “Add a Paper” or “Add an Embellishment.” Generally, papers are added   
as JPG files, and embellishments are added as PNG files (a PNG file has a portion 
of the file that is transparent). 

 
Q:  Do StoryBook Creator 2.0 and StoryBook Creator Plus work on Apple Mac 

computers? 
 
A:  Potentially. While StoryBook Creator was developed using a platform not supported 

by the traditional Mac OS operating system, we have successfully tested our 
software on newer Macs that include an Intel Processor. The user would need to 
have a newer Mac, the Windows Operating System and PC emulation software such 
as Bootcamp or Parallels in order to run our software. Although this solution does 
work, it is not an officially supported solution. 

 
Q:  Can I set a default font that’s used throughout my StoryBook? 
 
A:  You can set a default font using StoryBook Creator Plus if you are building a page 

completely from scratch. If you are creating your book from the predesigned pages, 
the font will always default to the font the designer used when creating the templates. 
However, if you add a text box to a page, it will use whatever default font setting you 
have created. 

  
Q:  How do I delete a project from the software? 
 
A:  Because the software allows you to choose where you save your projects, there is 

not a “delete project” button available. To delete a project, you’ll need to browse in 
your computer to where the file is located and delete it manually.  

 
Q:  Where do I get help learning to use the software? 
 
A:  The Help section of the software contains the entire User’s Guide and is very easy to 

use. We also have online video training available on creativememories.com.  
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StoryBook Creator Plus Software — Tips and Tricks 
 
Q:  The mat function only allows a solid color. How do I mat a photo with patterned 

paper? 
 
A:  You can cut a square out of any paper using the rectangle cutter, and then place this 

square behind your photo. To get a more exact size, copy your photo, and then 
choose to fill the copy with a patterned paper. You can then enlarge it just a bit and 
put it behind your photo. 

 
Q:  Can I double-mat a photo? 
 
A:  Definitely! It’s not an automatic function, but you can mat the photo automatically and 

then create a square of colored paper to go beneath the photo and mat. 
 
Q:  Am I able to flip the paper to create a mirror image of the actual background paper I 

used on the opposite page? 
 
A:  Sure! You can flip anything on the page by going to the Layout tab and choosing Flip 

Horizontally from the Rotate section. 
 
Q:  Am I able to use a “Corner Maker” on my photos? 
 
A:  Yes. You can crop a photo into a rectangle with rounded corners. 
 
Q:  Once I have created a StoryBook, can the slide show be downloaded to a CD/DVD? 

Can I add music to a slide show? 
 
A:  The software does not currently have this capability. You can, however, play it on 

your laptop from the program and you can add music. 
 
Q:  Can you change the color of the text in the title stickers? 
 
A:  Yes! Just highlight the sticker, go to the Tools menu and choose Color from the Fill 

options. You can even use the Sample Color tool to match the color of something on 
your page. 

 
Q:  When I share my StoryBook through the Creative Memories Photo Center, can the 

people I share it with make changes to the book? 
 
A:  They will be able to view the book. However, they would need the original file from 

you and a copy of the software to make any changes to the book. When a book is 
uploaded to the Creative Memories Photo Center it is uploaded as a PDF file, not as 
a StoryBook file. 

 
Q:  Why do my photos look a bit grainy in my StoryBook, especially when compared to 

my 4 x 6 prints? 
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A:  StoryBooks are printed with a different process than 4 x 6 prints. This is not a true 

photographic printing process, but a digital process. So the quality will not be the 
same. A book printed using a photographic process would be very expensive! 

 
Q:  If my photos are a bit dark, will they print dark within the StoryBook? 
 
A:  Because the StoryBook is ordered as a PDF file, we are not able to add any photo 

enhancements to the photos, as we can when we print your 4 x 6 prints. If a photo is 
dark, you’ll want to lighten it with the StoryBook Creator Software before you order 
your book. Dark photos tend to be printed a bit darker in a StoryBook, especially 
when they are on the cover of your book. 

 
Q:  Can you copy an individual completed page from one StoryBook to another? 
 
A:  Yes. Just choose Import Page from the Pages section of the Home tab within the 

software. 
 
Q:  Can I have more than one book open at a time? 
 
A:  Yes. Just click on the blue book inside the yellow circle at the very top left corner of 

your book to show the Start menu. From there you can open another book or create 
a new one without closing your current book. This will allow you to easily copy and 
paste items from one book to another. 

 
Q:  If I create a 12 x 12 StoryBook, can I change the size to 8 x 8 in order to make a less 

expensive copy for friends or relatives? 
 
A:  Yes. But this is not an automatic process within the software. Your steps are: 

• Create a 12 x 12 StoryBook. 
• Open the 12 x 12 StoryBook and choose Save As to create a copy. 
• Open the copy and flatten each of your pages (under the Layout tab). 
• Create a custom 8 x 8 to be printed locally. 
• Import the 12 x 12 StoryBook into the custom 8 x 8. 
• Create a new 8 x 8 StoryBook with blank pages and import the custom 8 x 8 

pages into the 8 x 8 StoryBook. 
 
 
 


